PowerSchool End-of-Year Process (July 2025)
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Management Technology Helpdesk

NOTE: THIS PROCESS SHOULD BE PERFORMED:

· After all final grades have been stored
· You are ready to commit your schedule
· The Teacher Student Data Link submission has been submitted to the state
· After the 5-Year Follow-Up Survey has been completed for current graduates
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[bookmark: _Toc202171038]End-of-Year Data Preparation
[bookmark: _Toc93054589][bookmark: _Toc100370894][bookmark: _Toc101234470][bookmark: _Toc23849268]Prior to running the End-of-Year Process, it is recommended to prepare and validate data.
[bookmark: _Toc202171039]Validate Enrollment Dates
Validate section enrollment and school enrollment data using the Section Enrollment Audit report and the School Enrollment Audit report. These reports will help identify any entry and exit date discrepancies with section or school enrollments. Make any corrections necessary.
*The below functions can only be run at the school level.
[bookmark: _Toc202171040]Section Enrollment Audit
Start Page > Data & Reporting > Reports > System Reports
Use the Section Enrollment Audit report to detect:
· Students enrolled in school, but not in any classes
· Students with course date misalignments with school enrollments
[bookmark: _Toc202171041]School Enrollment Audit
Start Page > Data & Reporting > Reports > System Reports
Use the School Enrollment Audit report to detect:
· Students with enrollment date overlap or misalignment
[bookmark: _Toc202171042]Clear Scheduling Settings Screen for Inactive Students (District Office)
From the Start Page, search for all inactive and transferred out students from the current school year using the search command: 
/enroll_status#0;enroll_status#-1;entrydate>=MM/DD/YYYY (MM/DD/YYYY=first day of school)
Clear the following scheduling settings fields in mass for inactive/transferred out students:
Next Year Grade (Sched_NextYearGrade)
Schedule This Student (Sched_Scheduled)
Year of Graduation (Sched_YearOfGraduation)
Next School Indicator (Next_School)

[bookmark: _Toc202171043]
Next Year Grade/Next School Indicator
The next year grade and next school indicator are both assigned to each student on the Scheduling Setup screen (Start Page > Select Student > Courses & Programs > Scheduling Settings).
The next year grade indicator (Sched_NextYearGrade) is used to determine the grade level that a student will be assigned to for the next school year.
The next school indicator (Next_School) is used to determine the school that a student will attend in the next school year.
NOTE: For Enrollment Express districts - Pre-registered (enroll_status=-1) students that have a next year school set as a different building than the one they are currently enrolled at will not move to that new building. Pre-registered students in this case should be made active before doing EOY rollover to prevent issues with the students rolling to the correct building. Pre-registered students whose next year school is the same building as the one they are currently in are not impacted and can be left as pre-registered.
There are several ways to check the next year grade and next school indicator: (Run at the school level)
Custom Students List Function
EOY Grade and School Checker Report (Engine)
Roll Over Errors Report (Custom Reports)
[bookmark: _Toc202171044]List Students Function
1. From the Start Page, search for all active and pre-registered students using the search command: /enroll_status in -1,0

NOTE: When confirming pre-registered students, the current school and current grade will be the same as their next year school and next year grade.

2. Select Custom Student List from the Group Functions menu below the search results.
3. On the Custom Student List page, enter the following fields:

	Field Name
	Column Title

	LastFirst
	Name

	SchoolID
	Current School

	Grade_Level
	Current Grade

	Next_School
	Next Year School

	Sched_NextYearGrade
	Next Year Grade



4. Click submit.
5. Read through the list and verify that all students have the correct next year grade and next school displayed. 
6. Make note of any student with incorrect or missing information. Correct in the Scheduling Setup screen.
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[bookmark: _Toc202171045]EOY Grade and School Checker Report
Start Page > Data & Reporting > Reports > Engine Reports > EOY Grade & School Checker
*This report can only be run at the school level.
This report will list students along with their grade level, next year grade level, and next school. The report will highlight any students that have a next year grade level that is less than or equal to the current grade level or if the next year grade level is more than one grade higher than the current grade level. The report will also highlight any student that does not have a next school assigned.

**NOTE: This report must be run with a selection of students less than 1000. If more than 1000 students are selected, the report will produce a blank report with headers only. 
[bookmark: _Toc202171046]Roll Over Errors Report
Start Page > PSCB Dev Reports > Validation Section > Year End Setup Errors  
This report will list students and display errors such as:
· Active Student, Next Year Grade = (0,0)
· Pre-Enrolled, Next Year Grade should match current grade
· Active/Pre-enrolled student with no school set for next year
· Next Year Grade suggests Graduating but Next year school does not
· Next Year School suggests Graduating but Next year grade does not
· Next Year Grade not in grade range for school
· SchoolID and Enrollment SchoolID should match for Active/Pre-enrolled students
[bookmark: _Toc202171047]Print Reports/Export Data
Prior to the End-of-Year Process, run/print any reports or export any data your district may send home or archive for the current school year. 

Some examples being:
· Report Cards
· Transcripts
· Object Reports/Form Letters (Ex: Fees - Do both reports)
· Attendance Reports
· Teacher Gradebook Reports
· Historical Grades Data
· 5-Year Follow-Up Survey Data (Requested by MISD)

[bookmark: _Toc202171048]5-Year Follow-Up Survey Data Export
Current year (June 20## class) graduate data should be exported and archived for each of your high schools for when the MISD requests data for the 5-Year Follow-Up Survey. Make sure to save the file with the correct school name and graduating class year. Below are the data requirements with sample instructions that the MISD usually sends out with their request for data. Save this data for your current year graduates.

This year, for our 5-Year Follow-Up, we are collecting information for the graduating class of 2024. This email may be forwarded to your Pupil Accounting person familiar with exporting files from your pupil accounting system. In 2024, your school was most likely using PowerSchool. The information needed is in the list below. Thank you for your cooperation in this important effort.
INFORMATION NEEDED
This list should include all students, not just CTE, who graduated from your high school in 2024. (Senior who only attended but did not graduate should not be included.)
Please put the information into an Excel file. The file should be named in the following format: “YourSchoolNameClassof2024” and then saved to the secure FTP site and the Help Desk should be emailed when complete. If you have any questions, please contact the Help Desk at help@misd.net or 586-228-3399. 
	[image: A screenshot of a computer

Description automatically generated]
*Parent Information is used to help in our use of a People Finder program to locate student’s new address. It is particularly helpful to have the first and last name of whomever the student was living with in 2024; especially since that person often has a last name that is totally different from the student’s. For the Parent Information field, we’ll take whatever information you have; whether it is in one cell or in separate cells, such as, one with father’s last name, father’s first name, mother’s last name, and mother’s first name. All of it helps. Please put Parent Information in the last of the cells.


[bookmark: _Toc202171049]Years and Terms
Years and terms affect many aspects of PowerSchool, such as the calendar setup, scheduling, enrollment, and final grades. 
You must create the new school year for all schools in your district whether you are using the school or not. This includes District Office and the Graduated Students School. This must be created on the live-side.
When setting up the new school year, give yourself an extra day due to any adjustment in the calendar. 
When setting up your terms (EX: S1), the end dates need to be “true” end dates. This affects the exit date for students in the CC table. 
When performing the End-of-Year Process, PowerSchool uses the first day of the term for the student’s entry date and the day after the last day of the term for the student’s exit date. 
Upon creating a new school year, PowerSchool creates the following attendance setup items:
· Attendance Codes
· Attendance Code Categories
· Attendance Preferences
· Attendance Conversions
· Bell Schedules
· Full-Time Equivalencies
· Calendar Day records are created for the new school year
For school buildings using PowerScheduler, all terms should be defined within PowerScheduler in the Years and Terms setup area. These will copy over and overwrite any years and terms defined on the live-side.
For school buildings not using PowerScheduler, all terms should be defined on the live-side only.
[bookmark: _Toc202171050]Clear Activities
Start Page > District Management > Courses & Programs > Remove Students From Extracurricular Activities
All student activities are automatically carried over during the End-of-Year Process. Clear any student activities that should not carry over into the next school year. This task can be accomplished by using the Clear Activities function.
[bookmark: _Toc202171051]Full-Time Equivalencies
Start Page > School Management > Attendance > Full-Time Equivalencies
Verify that each school building has the necessary Full-Time Equivalencies setup. Full-Time Equivalencies are used for certain attendance calculations.
[bookmark: _Toc202171052]Fees
Configure school and course enrollment fees. School enrollment fees are assessed automatically when running the End-of-Year Process. Course enrollment fees are assessed when committing your schedule from PowerScheduler to the live side. Both school and course enrollment fees may also be assessed individually or in mass after enrollment in a school or course.
When the End-of-Year Process is run, only the balance is rolled over into a Start-of-Year (SOY) fee. All individual detailed fee information is no longer available.
*The below functions can only be run at the school level.
[bookmark: _Toc202171053]Printing Fees Invoice
To print the Fees Invoice report, follow these steps:
1. From the Start Page, search for students with outstanding fees by using the search command: *fee_balance.balance>0
2. Select Print A Student Report from the Group Functions menu below the search results.
3. Select the Fees-Invoice report.
4. Click submit.
[bookmark: _Toc202171054]Custom Student List/Export of Student Fee Balance
To list students and/or export students and their fee balance, use the following code:
· Custom Student List: fee_GetStudentBalance
· Quick Export: ^(fee_GetStudentBalance)


[bookmark: _Toc202171055]Enrollment History and Graduation Information
It is necessary to update the graduated students exit code, exit date, and graduation information fields located on the Transfer Info and Graduation Information screens. 
School Enrollment > Enrollment History > Current Enrollment record
More > Graduation Information
[bookmark: _Toc202171056]Create the Export File
1. Navigate to the Transfer Info and Graduation Information report:
Start Page > Data & Reporting > Reports > sqlReports > End Of Year Process > Transfer Info and Graduation Information
2. Key in 9/30/20## in the Entry Date parameter
3. Click the submit button
4. Once the report generates, click the TAB button at the top of the report to download a text tab-delimited file
5. Review the saved file in Excel and make any necessary corrections
6. Save the file as a text (tab-delimited) file
[bookmark: _Toc202171057]Import the Export File
*The below function should only be done at district office.

1. Navigate to the Quick Import screen:
Start Page > Data & Reporting > Imports > Quick Import
2. Select the Students table from the drop-down menu.
3. Leave the Field delimiter, End-of-line marker, and Character Set to their default values.
4. Browse for the saved file.
5. Leave the Suggest field map box checked.
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6. Click import.
7. Map the fields the data will be imported in to:
	From File
	To PowerSchool

	LastFirst
	LastFirst

	Student_Number
	Student_Number

	SE
	(do not map)

	EMC
	(do not map)

	IAM
	(do not map)

	ExitDate
	ExitDate

	U_MISD.GradDate
	U_MISD.GradDate

	ExitCode
	ExitCode

	U_MISD.GradCode
	U_MISD.GradCode

	U_MISD.GradStatus
	U_MISD.GradStatus

	Graduated_SchoolName
	Graduated_SchoolName

	Graduated_SchoolID
	Graduated_SchoolID

	U_MISD.HSCohortYear
	U_MISD.HScohortYear


8. Make sure Check to exclude first row is checked.
9. Make sure to select the radio button: Update the student’s record with the information from the file being imported.
[image: ]
10. Click submit.
11. Verify all records imported successfully.
[bookmark: _Toc202171058]Populate the Class Rank and GPA Fields
The class rank and GPA fields on the Graduation Information screen will be updated by an import of data into the Students table within PowerSchool.
*The below should be performed at the school level and students should be selected. 
NOTE: For the IAM and 5th year ECM student, “Other District” consortium “Other Info” – check to exclude from Class rank.
1. Open a new tab and navigate to the Quick Export screen:
Start Page > Data & Reporting > Exports > Quick Student Export
2. Enter in the following fields:
· Student_Number
· LastFirst
3. Switch back to the other tab and navigate to the GPA Student Screens:
Start Page > School Management > Academics > GPA Info for Student Screens
4. Copy the class rank method from the GPA Student Screens.
5. Switch back to the Quick Export screen and paste the copied method under the LastFirst field.
6. Switch back to the GPA Student Screens tab and copy the cumulative GPA (NOT current) method.
7. Switch back to the Quick Export screen and paste the copied method under the class rank method.
8. Click submit and save the file.
9. Review the saved file in Excel and make any necessary corrections. Once finished, save the file as a text tab delimited file (.txt)
10. Navigate to the Quick Import screen:
Start Page > Data & Reporting > Imports > Quick Import 
11. Select the Students table from the drop-down menu.
12. Leave the Field delimiter, End-of-line marker, and Character Set to their default values.
13. Browse for the saved file.
14. Leave the Suggest field map box checked.
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15. Click import.
16. Map the fields the data will be imported in to:
	From File
	To PowerSchool

	Student Number
	Student_Number

	Student Name
	LastFirst

	Class Rank Method
	U_MISD.GradClassRank

	GPA Method
	U_MISD.GradCumulativeGPA


17. Make sure Check to exclude first row is checked.
18. Make sure to select the radio button: Update the student’s record with the information from the file being imported.
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19. Click submit.
20. Verify all records imported successfully.

[bookmark: _Toc202171059]Transcript Attendance
Use this process to update the Attend tab on the State/Province–MI page. The data from this report can be used to track student membership for each school year and can be pulled onto the student transcript.
NOTE: Recommended that transcripts are processed and saved the day after school gets out. 
Data & Reporting > Reports > Compliance Reports > MI Attendance for Transcript
On the report interface, select the option to run for All Students.
Enter in the Start Date of the school year.
Enter in the End Date of the school year.
Click submit.
When the report is completed, right click on the completed link and save the CSV file to a location on your computer.
[bookmark: _Toc202171060]Importing into PowerSchool
1. Navigate to the Quick Import screen:
Start Page > Data & Reporting > Imports > Quick Import
1. Select the Students table from the drop-down menu.
1. Select Other from the Field delimiter drop-down menu and enter a comma in the box to the right.
1. Leave the End-of-line marker set to the default and change Character Set to Mac Roman.
1. Browse for the saved file.
1. Leave the Suggest field map box checked.
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1. Click Import.
1. All fields that need to be imported will automatically map to the correct PowerSchool field name. Fields after S_MI_STU_GC_X.att12grDaysEnroll will not map and should not be mapped.
1. Make sure Check to exclude first row is checked.
1. Make sure to select the radio button: Update the student’s record with the information from the file being imported.
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1. Click submit.
1. Verify all records imported successfully.
[bookmark: _Toc202171061]Importing Fall GC Data into Special Education Start Date
PowerSchool uses the Special Education Entry Date (S_MI_STU_GC_X.seStartDate) field to identify a student as being a special education student during the year. If this field is not filled out, the Special Education data will not pull out correctly in the PowerSchool generated CRDC reports.

Since the CRDC collection looks at the Fall Snapshot data for Special Education students, it is recommended to take your Fall General Collection file and import any Special Ed dates into the S_MI_STU_GC_X.seStartDate field.

1. Download the MISDmsds Error Checker onto your computer if not already downloaded
Take your Fall General Collection file for the 24-25 school year and import the file into the MISDmsds Error Checker
12. You can use the file you already downloaded from CEPI OR log into CEPI (MSDS) and download the file fresh
After importing the Fall General Collection file in the error checker, go to:
12. File -> Export -> Export MSDS Data for PowerSchool
12. Save the file to a safe location (like desktop or flash drive)
Once the file is saved, browse to it and open it in excel
In Excel, delete all columns EXCEPT:
12. Student_Number
12. mi_SpEd_AdditionalDisability (OR IEPStartDate – look for the date)
Rename the mi_SpEd_AdditionalDisability (OR IEPStartDate – look for the date) column to S_MI_STU_GC_X.seStartDate
Remove students with blank information in the S_MI_STU_GC_X.seStartDate column
12. Filter the S_MI_STU_GC_X.seStartDate column to only show blanks
12. Delete the rows of students with blank data
 Remove the filter for the S_MI_STU_GC_X.seStartDate column
 Save the file as a text tab delimited (.txt)
 Go into PowerSchool at the District level and go to Data & Reporting > Imports > Quick Import on the left-hand side
Use these settings for the import:
12. Table: Students
12. Field Delimited: leave as is
12. End-of-line marker: leave as is
12. Character set: leave as is
12. File to import: select the file you saved earlier
 Press import at the bottom of the page
 The next page should automatically map the fields for you at the top
 Click the “Check to exclude first row” checkbox
 Select “Update the student's record with the information from the file being imported. (Note: Even if you have this option selected, if the student is in a different school, the information will not be updated.).” under the Advanced Import Options setting
 Press submit at the bottom of the page. Wait for the data to be finished importing.
 Once finished, verify that the information imported by checking a few students Compliance > Special Education component.
[bookmark: _Toc202171062]End-of-Year Process Validation
The End-of-Year Process includes a validation mode during which the system will evaluate student, school, and district information for End-of-Year readiness. The End-of-Year Process will not run unless all students and schools are properly configured for new enrollments in the upcoming school year. 
*The below can only be performed at the district level and make sure to have the year set to 24-25 for the 25-26 school year.
[bookmark: _Toc517701689][bookmark: _Toc202171063]Setup End-of-Year Process Screen
Start Page > District Management > School Rollover > End-of-Year Processing
The End-of-Year Process screen requires set up and verification of three areas:
· Validation of the High Grade and Default Next School
· Setup of the Exit Code for Current Enrollment, Entry Code for New Enrollment, and Exit Comment for pre-defined types of students
· Transfer Method of Fees
[bookmark: _Toc202171064]Validate High Grade and Default Next School
Validate that each school in the district is set up with a valid high grade and a valid default next school for students that are in the high grade.
If any modifications are required, these can be made on the Schools/School Info screen. (Start Page > District Management > District Setup > School Info > Select a School)
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[bookmark: _Toc202171065]Exit Code for Current Enrollment
Select the appropriate exit code for each type of student: Graduating, Promoted to next school, Promoted within same school, Retained, and Demoted. The End-of-Year Process assigns these exit codes to each student’s current enrollment based on a comparison of the student’s current school, next school indicator, current grade level, and next grade level.
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[bookmark: _Toc202171066]Entry Code for New Enrollment
Select the appropriate entry code for each type of student: Graduating, Promoted to next school, Promoted within same school, Retained, and Demoted. The End-of-Year Process assigns these entry codes to each student’s new enrollment based on a comparison of the student’s current school, next school indicator, current grade level, and next grade level.
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[bookmark: _Toc202171067]Exit Comment
Type in an exit comment for each type of student: Graduating, Promoted to next school, Promoted within same school, Retained, and Demoted. The End-of-Year Process assigns these exit comments to each student’s current enrollment based on a comparison of the student’s current school, next school indicator, current grade level, and next grade level.
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[bookmark: _Toc202171068]Fees Transfer Method
Select a fee transfer method:
· Roll over the current balance option - Any student with a non-zero fee balance for the current school year will be given a Start-of-Year (SOY) balance in their fee transactions for the upcoming school year. All individual detailed fee information is no longer available.
· Zero the current balance option – All students will start the upcoming school year with a zero balance in their fee transactions. No fee balance will be carried over from the current school year.

[bookmark: _Toc202171069]Perform End-of-Year Process Validation
The End-of-Year Process Validation will check each school and each student for End-of-Year readiness. Any validation errors are displayed on screen.
There are two validation options:
· Perform EOY Validation
· Perform EOY Validation and make any students with issues the current selection
Both options will display the same validation error messages. The only difference is that the second option will make any students with validation errors the current selection. The first option will only display the validation error messages without changing any previous selection of students you may have had.
Once the validation option has been selected, click the Perform End-of-Year Processing button.
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[bookmark: _Toc202171070]Review and Correct Errors
After running the End-of-Year Process Validation, correct any of the validation error messages that appear.
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[bookmark: _Toc202171071]Validation Error Messages
The following error messages may appear when performing the End-of-Year Process Validation. Refer to this section to identify the solution for each error message.
[bookmark: _Toc202171072]Error Messages and Solutions
	Error Message
	Solution

	Next_School is blank
	Assign the student a Next School Indicator on the Scheduling Setup screen.

	Next School is “High School” and next grade is 0, not 9-12
	If the student is already assigned to the correct Next School, correct the student’s Next Year Grade on the Scheduling Setup Screen. If the student is assigned to a correct Next year Grade, you may need to correct the student’s Next School Indicator on the Scheduling Setup Screen.

	Next_School (123456) is not a valid school in this district. Next School is “High School” and next grade is 12, not 0-0
	This issue is caused by an improperly configured Next School Indicator at the student’s current school. First, verify that the Next School Indicators at the student’s current school are configured with a valid school number at Start Page > School > Next School. Once the Next School Indicators have been corrected at the student’s current school, select the student and assign a valid Next School Indicator on the Scheduling Setup screen.

	Grade Level is 99 and Next School Indicator is not “Graduated Students”
	If the student is supposed to graduate, set the student’s Next School Indicator to the Graduated Students School on the Scheduling Setup screen. If the student is not supposed to graduate, then correct the student’s Next Year Grade on the Scheduling Setup screen.

	School #### is not setup for next year
	Select the school that is not setup for next year and create the year term at Start Page > School > Years and Terms



[bookmark: _Toc202171073]End-of-Year System Preparation
Prior to committing the schedule and running the End-of-Year Process, the following tasks should be completed.
[bookmark: _Toc202171074]Set Larger Timeout for Admin Users
System Management > Security > System Security Settings
Set the option: Sign Off Administrative Users After This Many Minutes Of Inactivity to 120 (2 hours).
[bookmark: _Toc202171075]Disable Teacher Portal, Parent Portal, Student Portals and Mobile Apps
District Management > District Setup > Additional System Preferences
Place a check in the checkbox for the following options:
· Disable access to teacher portal
· Disable Student and Parent Portals/Mobile Apps
[bookmark: _Toc202171076]Turn off AutoComm Processes
To avoid the AutoComm processes from interfering with the End-of-Year Process, we recommend disabling the execution of AutoComms.
AutoComms are usually set up at the District level, but may also be school specific and set up at the School level. 
To turn the execution of an AutoComm off:
1. Navigate to the AutoComm Setup screen:
System Management > Data > AutoComm Records
2. Select the AutoComm name.
3. Check the box to Turn Execution Off.
4. Click submit. Disable Admin Login Screen
Once you are ready to begin the rollover process, you may hide the admin login fields from other users trying to access PowerSchool. 
To hide the admin login fields:
1. Navigate to the Hide Admin Login screen:
District Management > Hide Admin Login

2. Check on the ‘Enable Hiding Admin Login Fields’ checkbox.

3. Type in a password in the blank text box.
NOTE: Make sure that there are no spaces in the text box and do not use special characters

4. Make note of the additional characters in the URL. You will need to add ?login=[PASS] to the end of the normal district PS URL to access the site until the checkbox is turned off.

5. Press Submit at the bottom of the page.
	
[bookmark: _Toc202171077]System Requests Performed by the MISD
The following tasks are necessary to secure the system prior to running the End-of-Year Process. The MISD Systems staff handle these tasks. Send requests by email to the helpdesk (help@misd.net) for these to be completed, also come out to the helpdesk and let us know that you sent the helpdesk in case we get busy and don’t see it right away.
· Backup of production PowerSchool server
*Date and Time required in request

Sample Email:
Dear Helpdesk,
Please perform the following tasks so we may complete the End-of-Year Process.

· Backup the production server as of: MM/DD/YYYY @ HH:MMam/pm

Please notify us when we may continue with the End-of-Year Process.

Thanks for being the best helpdesk staff ever!

Sincerely,
District PowerSchool Liaison
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[bookmark: _Toc202171078]Commit Schedules (Be careful with this portion) 
The next year schedule needs to be committed to the live-side for each school using PowerScheduler. 
NOTE: Disable the “Commit Button” from scheduling Secretaries. 
*The below can only be performed at the school level. Go to each school. Make sure to have the year set to 24-25 for the 25-26 school year.

**If you receive Dalx Sync Errors when committing schedules for a building, you will need to commit a second time. Let the first process complete, then perform the commit AGAIN. You will receive a warning when submitting, but the commit will complete. **
[bookmark: _Toc202171079]Split Year-Long Classes (EX: Year Long (same teacher & same period))
*The below can only be performed at the school level.
If applicable, make sure to run the Split Year-Long Classes PowerScheduler function prior to committing schedules.
Start Page > PowerScheduler > Functions > Split Year-Long Classes (once completed, spot check a few students. 
[bookmark: _Toc202171080]Pre-Commit Validation/Verification
· Years & Terms – In the next school year on the live side, verify that the term dates are set up correctly in PowerScheduler.
Start Page > PowerScheduler > Year & Terms > Edit Terms
· Individual Student Conflict Matrix – Run this report with a selected grade level of students. Choose the option to filter students by Only students with unfilled requests. Look for items in red that need to be fixed.
Start Page > PowerScheduler > Reports > Individual Student Conflict Matrix
NOTE: Save the file and send it to the schedulers to fix the errors.
· Student Schedule List
Start Page > PowerScheduler > Reports > Student Schedule List
· Pre-Commit Validation
Start Page > PowerScheduler > Reports > Pre-Commit Validation

[bookmark: _Toc202171081]Commit Schedules to the Live-Side
1. To commit the schedules, make sure you are in the current school (24-25) year on the live-side.
2. Navigate to:
Start Page > Applications > PowerScheduler > Commit
3. Select which schedules to copy:
· Sections Only – Select this option to commit only sections
· Student Schedules Only – Select this option to commit only student schedules
· Sections & Student Schedules – Select this option to commit both sections and student schedules

4. Click submit. The Verify Commit Master Schedule page appears.
5. Click submit. The Commit Master Schedule Warnings page displays if there are any conflicts or unavailable courses. If there are no conflicts or unavailable courses, skip to Step 6.
*Note: Only school calendar conflicts are committed as part of the master schedule; unavailable courses are not.
6. If you are certain you want to commit, click submit to proceed. The Changes Recorded page appears.
If you want to Suppress your schedules for the 25-26 school year, you can do so at this time.

***Note: Once schedules are committed to the live-side, all further scheduling changes must be made MANUALLY on the live-side and not in PowerScheduler.

Tip! Print the “Progress” page to verify that you have committed your schedules and keep the copy for your records. 
[bookmark: _Toc202171082]End-of-Year Process
The End-of-Year Process is used to close out the current school year and transfer all students to the grade level and school that each will be attending in the next school year. 
*The below can only be performed at the district level.

1. To perform the End-of-Year Process, make sure you are in the current school year.
2. Verify End-of-Year Process screen:
Start Page > District Management > School Rollover > End-of-Year Processing
3. Once the setup has been verified, select the Perform EOY and Promote Students option.
4. Click the Perform End-of-Year Processing button.
[image: ]
If you have cleared all validation error messages correctly, PowerSchool will begin performing the End-of-Year Process. Depending on the size of your district, the End-of-Year Process may take several hours to complete.
[bookmark: _Toc202171083]Progress and Completion Message
While the End-of-Year Process is running, it will provide feedback on the progress of the End-of-Year Process. Leave your web browser open to this page while the End-of-Year Process is running. Several messages will be displayed on screen such as:
· Validating student’s promotion readiness
· Promoting students and enrolling new students
· Moving balances
· Deleting XXXX records
· End-of-Year Process Complete
The End-of-Year Process is complete once the “End-of-Year Process Complete” message is displayed on screen. This message may not display if the web browser times out.
*Note: If the web browser times out or you accidentally close out of the browser window, the End-of-Year Process progress can be monitored in the PowerSchool server log.
(Start Page > System Management > Server > System Log > View current system log file)

[bookmark: _Toc202171084]Post End-of-Year Process Tasks
After the End-of-Year Process has been completed, there are a number of recommended tasks to perform before starting the school year.
NOTE: Spot check a few students at the elementary, middle, and high school to make sure everything came over properly. For example, contacts, FTE, Demographics, and grade level just to name a few.
NOTE: The EOY Process will automatically rollover your standards, make sure to double-check standards for accuracy. 
[bookmark: _Toc202171085]District and School Administration
The following settings affect student configuration and reporting in PowerSchool. Verify that the following setup areas are still correct and valid for the new school year. Make any changes that are necessary.
[bookmark: _Toc202171086]Code Sets
Start Page > System Management > Data > Code Sets > EntryCode / ExitCode
Use entry codes to identify reasons why students enroll in and transfer to your school. Use exit codes to identify the reasons why students leave your school.
[bookmark: _Toc202171087]School Information
Start Page > District Management > District Setup > School Info
Review and update the information for each school in your district, including the school’s address, contact information, school administration information, etc.
[bookmark: _Toc202171088]Default Term Level
Start Page > School Management > Display Preferences > Additional Preferences
Start Page > District Management > District Setup > Additional System Preferences
This setting determines the level displayed by default at the top of the page when in PowerSchool.
[bookmark: _Toc202171089]Default Term When Between School Years
Start Page > District Management > District Setup > Additional System Preferences 
This setting should be set to Previous School Year to disallow the students/parents to see the New Year’s schedule. You would need to remember to set this to Closest School Year or Next School Year when you are ready for the schedules to be seen.
[bookmark: _Toc202171090]Bell Schedule
NOTE: Verify with all schools of any changes. 
Start Page > School Management > Scheduling > Bell Schedules
Review each bell schedule for the following items:
· Verify that the bell schedules for each school contain the correct number of periods and are associated to the correct attendance conversion method.
· Only one bell schedule can be used per calendar day and the bell schedule determines which attendance conversion is used on a given day.
· Verify that each period in each bell schedule has the correct start time, end time, and is set to count in (or to be excluded from) ADA calculations.
· For meeting attendance, each period that counts in attendance should be checked for ADA.
[bookmark: _Toc202171091]Copy Master Schedule (Live Side)
[bookmark: _Toc202171092]This process is usually used for Elementary Buildings and some academies.
NOTE: If a district is using PowerScheduler for SECONDARY BUILDINGS, they do not have to run this.
Start Page > School Management > Scheduling > Copy Master Schedule
Use the Copy Master Schedule function to copy schedules from a previous school year. This function copies sections with all associated settings, such as term, expression, teacher, room, department, etc.
1. Select the Source Year (The school year from which you want to copy)
2. Select the Target Year (The school year to which you want to copy)
3. Decide whether to clear existing scheduling terms in the destination school year. Leave unchecked if you want the system to attempt to match the source and destination terms. If no matches are found, the source terms are added to the destination year. If checked, this function will copy the source terms to the destination year.
**NOTE: Sections that will be using PowerTeacher Pro that were PowerTeacher Gradebook sections in the current school year will need to be modified on a section-by-section basis or with a mass change through DDA. Refer to the “Switching Gradebook Type from PowerTeacher Gradebook to PowerTeacher Pro” document. If you need assistance, please contact the helpdesk.**

**NOTE: If all sections are to be using PowerTeacher Pro, make sure the Default Gradebook Type is set to PowerTeacher Pro in the PowerTeacher Pro Settings area in District Setup.** 

[bookmark: _Toc202171093]Calendar Setup
**NOTE: Do NOT set up the school calendar for any buildings that will be using the Copy Master Schedule function. The Copy Master Schedule function will reset any calendar work you do prior to running that function for those buildings. Set up the calendar after you do the Copy Master Schedule function.**
Verify that each day in your school calendar is properly configured with the correct day, bell schedule, in-session indicator, membership value, and type.
(Start Page > School Management > Scheduling > Configure Calendar)
The Automated Calendar Setup function can be used to mass fill the above information.
(Start Page > School Management > Scheduling > Configure Automated Calendar) – SEE SEPARATE HANDOUTS to complete this process.
The District Calendars function can be used to create one or more calendar templates which can be pushed to one or more schools.
(Start Page > District Management > Scheduling > District Calendars)
[bookmark: _Toc202171094]Early Warning System
Start Page > School Management  > MISD School Settings > Early Warning Setup
Update any Early Warning System Setup parameters that may have changed from the previous school year.

[bookmark: _Toc202171095]Scheduling
The following settings affect the scheduling of both school and course enrollments for students in PowerSchool. Verify that the following setup areas are still correct and valid for the new school year. Make any changes that are necessary.
[bookmark: _Toc202171096]Scheduling Security
Start Page > System Management > Security > Security Groups
After the End-of-Year Process has been completed, it is recommended to lockout schedulers from PowerScheduler (Administrators, Counselors, Schedulers, and Secretaries) as all schedule modifications must be done on the live-side. To do this, remove the checkmark from the PowerScheduler Access checkbox on the Edit Group page.
It is also recommended to update the school year that the schedulers are allowed to modify. To do this, select the new school year from the Can Modify Schedules drop-down menu on the Edit Group page.

[bookmark: _Toc202171097]Periods (Do for every school)
Start Page > School Management > Scheduling > Periods
Verify the number of periods and the period abbreviations for the new school year.
To adjust the number of periods in a given school year:
1. Navigate to:
Start Page > School Management > Scheduling > Years & Terms
2. Click the Year name to modify for the selected year.
3. Select the number of periods from the Periods drop-down menu.
4. Click submit.
[bookmark: _Toc202171098]Days (Do for every school)
Start Page > School Management > Scheduling > Cycle Days
Verify the number of days and the day abbreviations for the new school year.
To adjust the number of days in a given school year:
1. Navigate to:
Start Page > School Management > Scheduling > Years & Terms
2. Click the Year name to modify for the selected year.
3. Select the number of days from the Days drop-down menu.
4. Click submit.
[bookmark: _Toc202171099]Reset Class Counts (Do for every school and throughout the summer)
School > Course & Programs > Reset Class Counts
The Reset Class Counts function should be run to make sure that section enrollment numbers appear correctly on the Teacher Schedules. This function should be run after the school calendar has been set up.
[bookmark: _Toc202171100]Years and Terms
Start Page > School Management > Scheduling > Years & Terms
Start Page > District Management > Scheduling > Years & Terms
[bookmark: _Toc202171101]Verify Start and End Dates
Verify the start and end dates of the scheduling terms. Schedule terms define dates for scheduling students into school and sections/classes. Also, make sure the Import File Term # is filled out.
[image: ]
[bookmark: _Toc202171102]Hide Schedules for the Next School Year
In order to hide student schedules from appearing in the Parent Portal, the Suppress Classes For This Term From Parent/Student Users checkbox must be checked for each scheduling term you do not want to appear.
It is suggested to suppress all terms in mass through DDA to minimize the time that schedules may show for the next school, however, you can manually do this process as well. 
Start Page > School Management > Scheduling > Years & Terms (Scheduling Years & Terms – NOT Reporting Years & Terms)
[image: A screenshot of a computer
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1. Navigate to DDA
1. Change the Current Table to: Terms
1. In the first search box: [ ID ] >= [ 3500 ]
1. Click the Search all XXXX records in this table button
1. Click Modify Records
1. From the drop-down menu set: [ SuppressPublicView ] = 1
1. Click the Modify Selected Records button
[bookmark: _Toc202171103]Add the PSN Number to the Sections
If your district has a CTE program and you utilize the SQL reports for CTEIS (Work Based Learning and Credentials), you will need to add the PSN numbers to the sections. This can be done by hand or en masse.
To do so by hand, go to the School and then Courses and Programs > Master Course Schedule > Click on a section and add the PSN number at the top of the screen.
To do so en masse:
a. In PowerSchool, go to Data and Reporting > Exports > Data Export Manager
b. In Category select ‘Show All’ and then in ‘Export From’ select ‘Sections’.
c. Select these fields from the left hand menu:
i. Att_Mode_Code
ii. Attendance_Type_Code
iii. Course_Number
iv. Expression
v. GradebookType
vi. SchoolID
vii. Section_Number
viii. Teacher
ix. TermID
x. U_CTEIS.psn
d. Press next. On the next page, underneath the Filter header click the dropdown and select TermID and make it greater than or equal to 3500 (TermID>=3500). Click Next.
i. NOTE: You may also want to filter by SchoolID here. If you would like to do so, click the + icon and select SchoolID from the new dropdown box. You may also want to filter by Course_Number if you have a special number convention for the CTE courses.
e. Click Export. Once the file is done exporting, open the download in Excel.
f. In Excel, go through the courses that should have a PSN number and add the PSN number to the U_CTEIS.PSN column per course per school. Once completed, save as a text tab delimited file.
g. Go back into PowerSchool and go to Data and Reporting > Imports > Quick Import
h. In the Table dropdown select ‘Sections (Master Schedule)’. Click ‘Choose File’ and select the PSN Excel spreadsheet. Press import.
i. Map the fields in step c to the fields in the dropdowns on the page. See screenshot below. 
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j. Select ‘Check to exclude first row’ and ‘Update section records if an imported record matches an existing section (“matching means same course and section numbers in the current school year.) Then press Submit.
k. This process will take a moment. Wait for the page to finish processing and then scroll through the page for any red lettering. Those are sections that failed and will need to be investigated.
l. To verify that the import was successful, go to Courses and Programs > Master Course Schedule > select one of the CTE sections. Verify that a number is in the PSN field at the top of the sections page.

[bookmark: _Toc202171104]Attendance
The following settings affect the calculation of attendance and membership in PowerSchool. Verify that the following setup areas are still correct and valid for the new school year. Make any changes that are necessary.
[bookmark: _Toc202171105]Attendance Codes
Start Page > School Management > Attendance > Attendance Codes
Review the Attendance Codes set up for the new school year. Ensure that the proper codes are designated as presences and absences and are properly counted in ADA.
[bookmark: _Toc202171106]Attendance Code Categories
Start Page > School Management > Attendance > Attendance Code Categories
Verify that the correct Attendance Code Categories are set up for the new school year. The schools must use the Excused, Unexcused, and Tardy attendance code categories and shouldn’t change or delete these (because they may have been used in previous school years). Attendance codes must be associated with the tardy attendance code category in order to be properly recognized as tardy.
[bookmark: _Toc202171107]Full-Time Equivalencies
Start Page > School Management > Attendance > Full-Time Equivalencies (FTE)
FTEs are used for reporting on ADA/ADM and to indicate what portion of a school day students attend (full-time and half-time students). Ensure that each FTE has a default attendance mode and has a default attendance conversion method. Note: You cannot have two defined FTEs in a different name.
[bookmark: _Toc202171108]Attendance Conversions
Start Page > School Management > Attendance > Attendance Conversions
Verify that each attendance conversion is correctly defined for each full-time equivalency.
[bookmark: _Toc202171109]Attendance Preferences
Start Page > School Management > Attendance > Attendance Preferences
Verify that the attendance preferences are correctly set up for each school in your district.
[bookmark: _Toc202171110]Grading
The following settings affect the calculation and display of current and historical grades in PowerSchool. Verify that the following setup areas are still correct and valid for the new school year. Make any changes that are necessary.
[bookmark: _Toc202171111]GPA Calculations
Start Page > District Management > Academics > GPA Calculation Methods
Update any GPA Calculations that are set up with year specific query options and make any other necessary changes.
[bookmark: _Toc202171112]Final Grade Reporting Term Setup/Copy Final Grade Setup
Start Page > School Management > Academics  > Create Final Grade & Reporting Term
Start Page > School Management > Academics > Copy Final Grade Setup
Use Final Grades Setup to view and set up your school’s grading terms and their parameters. Define the dates of each grading term in the school year and assignment names for which teachers enter final grades for those terms.
A Copy Final Grade Setups function is available to copy the final grade setups from one building to another. The final grade setups must be set up in one building prior to copying to another. Once created in the first building, switch to the building that is not set up and use the copy final grade setup function. Only use this function to copy final grade setups for buildings that will have the same final grade setup structure. (Elementary building to Elementary building, etc.)
NOTE: For the Teacher Student Data Link (TSDL), make sure that the appropriate terms are checked on. 
[bookmark: _Toc202171113]Current Grade Display 
(Note: This needs to be changed to the current term throughout the school year.)
Start Page > School Management > Academics > Set Current Grade Display
Use Current Grade Display to set up or change how the system displays a student’s grade and attendance information on the Quick Lookup page in PowerSchool and the Current Grades and Attendance page that parents use in PowerSchool Student and Parent Portal.
[bookmark: _Toc202171114]GPA Student Screens
Start Page > School Management > Academics > GPA Info for Student Screens
Use the GPA Student Screens function to determine what appears on GPA-related student pages, including the Quick Lookup page and the Cumulative Information page. Update any GPA Calculations that are set up with year specific query options and make any other necessary changes.
[bookmark: _Toc202171115]Honor Roll
Start Page > School Management > Academics > Honor Roll Methods
Configure honor roll methods and levels at each school. The grades included in the honor roll calculations are based on the associated GPA calculations set up at the District Office. 
Review the GPA Calculation associated with each honor roll level and ensure that the calculation is configured properly for the current school year.
[bookmark: _Toc202171116]Class Rank
Start Page > School Management > Academics > Class Rank Methods
Review each class rank method and ensure each is associated to the correct GPA calculation method.

[bookmark: _Toc202171117]Student Information
The following settings affect several reports and functions throughout PowerSchool. Verify that the following setup areas are still correct and valid for the new school year. Make any changes that are necessary.
[bookmark: _Toc202171118]Full-Time Equivalency (District Office)
Search for students without a Full-Time Equivalency. If any students are returned, update their current school enrollment on their Transfer Info student screen with an FTE. Students without an FTE will cause invalid ADA calculations.
1. Perform the following search on the Start Page:
FTEID=
2. If PowerSchool returns one or more students, update each student record and assign the student an appropriate FTE on the Transfer Info student screen.
[bookmark: _Toc202171119]School Enrollments (School Level)
Start Page > Data & Reporting > Reports > System Reports > School Enrollment Audit
Run the School Enrollment Audit report to identify any invalid school enrollments. School enrollments may be updated on the Enrollment History student screen.

[bookmark: _Toc202171120]System Administration and Security
Verify that the following setup areas are still correct and valid for the new school year. Make any changes that are necessary.
[bookmark: _Toc202171121]Turn on AutoComm Processes
Turn on any AutoComm processes that may have been turned off prior to the End-of-Year Process. 
AutoComms are usually set up at the District level, but may also be school specific and set up at the School level. 
To turn the execution of an AutoComm on:
1. Navigate to the AutoComm Setup screen:
System Management > Data > AutoComm Records
2. Select the AutoComm name.
3. Uncheck the Turn Execution Off checkbox.
4. Click submit.
[bookmark: _Toc202171122]Set Shorter Timeout for Admin Users
System Management > Security > System Security Settings
Set the option: Sign Off Administrative Users After This Many Minutes Of Inactivity to a shorter amount of time (district decision).
[bookmark: _Toc202171123]Sandbox Data
Please send a message to the Helpdesk (help@misd.net) with your preference on what should happen with your sandbox:
Leave current sandbox data as is
Load data from the backup taken just prior to rollover
Load current live data (post rollover)
After your production environment is open to the outside, we will place your sandbox in the queue to be upgraded to match the version of your production environment.
[bookmark: _Toc202171124]PowerSchool Special Education (TIEnet)
Upon completion of the EOY rollover, an email needs to be sent to Leslie Budnick (lbudnick@misd.net) letting her know that your district rollover is complete so that she can synchronize the programs and services for the new school year. 
[bookmark: _Toc202171125]Enabled Admin Login Screen
Once you are ready to let other admin users back into the SIS, you’ll need to re-enable the admin login screen. 
To enable the admin login fields:
1. Navigate to the Hide Admin Login screen:
District Management > Hide Admin Login
2. Un-check the ‘Enable Hiding Admin Login Fields’ checkbox.
3. Press submit at the bottom of the page.
[bookmark: _Toc202171126]Clear S_MI_STU_GC_X.seStartDate field
Once all of the above tasks have been completed, you can now clear the S_MI_STU_GC_X.seStartDate field that was imported earlier. This field was only used for the End-of-Year Process.
To clear the field:
1. Navigate to the PowerSchool District start page:
2. In the search, do a / and press submit.
a. This will give you all of your students
3. Under the student selection, select the down arrow next to ‘select function’
a. In the list, select ‘Change Student Field Value’
4. In the ‘Field to Change’, enter in S_MI_STU_GC_X.seStartDate
5. Select the ‘Clear Field Value’ checkbox
6. Press submit at the bottom of the page
7. Press submit at the bottom of the page
[bookmark: _Toc202171127]Clear S_MI_STU_GC_X.lunchStatus_Override field
Following the EOY process, districts may want to clear the S_MI_STU_GC_X.lunchStatus_Override field to accurately report lunch status for students. If this field is not cleared, the data will remain for the Fall count period.
To clear the field:
1. Navigate to the PowerSchool District start page:
2. In the search, do a / and press submit.
a. This will give you all of your students
3. Under the student selection, select the down arrow next to ‘select function’
a. In the list, select ‘Change Student Field Value’
4. In the ‘Field to Change’, enter in S_MI_STU_GC_X.lunchStatus_Override
5. Select the ‘Clear Field Value’ checkbox
6. Press submit at the bottom of the page
7. Press submit at the bottom of the page

[bookmark: _Toc202171128]End-of-Year Process Checklist
[bookmark: _Toc202171129]End-of-Year Data Preparation Checklist
	Process
	School Buildings

	Validate Enrollment Dates

	Section Enrollment Audit
	
	
	
	
	
	
	
	
	

	School Enrollment Audit
	
	
	
	
	
	
	
	
	

	Scheduling Setup Screen

	Clear Scheduling Setup Screen for Inactive Students
	
	
	
	
	
	
	
	
	

	Next Year Grade/Next School Indicator

	List Students Function
	
	
	
	
	
	
	
	
	

	EOY Grade and School Checker Report
	
	
	
	
	
	
	
	
	

	Roll Over Errors Report
	
	
	
	
	
	
	
	
	

	Archive Data/Reports

	Print Reports/Export Data
	
	
	
	
	
	
	
	
	

	5-Year Follow-Up Survey Data
	
	
	
	
	
	
	
	
	

	Years and Terms

	Create/Verify New School Year
	
	
	
	
	
	
	
	
	

	Activities

	Clear Activities
	
	
	
	
	
	
	
	
	

	Full-Time Equivalencies

	Set up Full-Time Equivalencies
	
	
	
	
	
	
	
	
	

	Fees

	Printing Fees Invoice
	
	
	
	
	
	
	
	
	

	List Students/Export of Student Fee Balance
	
	
	
	
	
	
	
	
	

	Transfer Info and Graduation Information

	Create/Update/Import Export File
	
	
	
	
	
	
	
	
	

	Populate Class Rank and GPA Fields
	
	
	
	
	
	
	
	
	

	Transcript Attendance

	Import Transcript Attendance Data
	
	
	
	
	
	
	
	
	



[bookmark: _Toc202171130]End-of-Year Process Validation Checklist
	Process
	School Buildings

	Setup End-of-Year Process Screen

	Validate High Grade and Default Next School
	
	
	
	
	
	
	
	
	

	Exit Code for Current Enrollments (Code Sets)
	
	
	
	
	
	
	
	
	

	Entry Code for New Enrollments (Code Sets)
	
	
	
	
	
	
	
	
	

	Exit Comments
	
	
	
	
	
	
	
	
	

	Fee Transfer Method
	
	
	
	
	
	
	
	
	

	Perform End-of-Year Process Validation

	Review and Correct Validation Error Messages
	
	
	
	
	
	
	
	
	


[bookmark: _Toc202171131]End-of-Year Process System Preparation Checklist
	Process
	School Buildings

	System Preparation
	
	
	
	
	
	
	
	
	

	Set Larger Timeout for Admin Users

	Disable Teacher and Parent Portals
	
	
	
	
	
	
	
	
	

	Turn off AutoComm Processes
	
	
	
	
	
	
	
	
	

	System Requests Performed by the MISD
	
	
	
	
	
	
	
	
	

	Commit Schedules Checklist
	
	
	
	
	
	
	
	
	



	Process
	School Buildings

	Commit Schedules Process
	
	
	
	
	
	
	
	
	

	Split Year-Long Classes

	Pre-Commit Validation/Verification
	
	
	
	
	
	
	
	
	

	Commit Schedules to the Live-Side
	
	
	
	
	
	
	
	
	

	
	
	
	
	
	
	
	
	
	



[bookmark: _Toc202171132]End-of-Year Process Checklist
	Process
	School Buildings

	End-of-Year Process

	Verify End-of-Year Process Screen Setup
	
	
	
	
	
	
	
	
	

	Run End-of-Year Process
	
	
	
	
	
	
	
	
	


[bookmark: _Toc202171133]Post End-of-Year Process Checklist
	Process
	School Buildings

	District and School Administration

	Entry and Exit Codes
	
	
	
	
	
	
	
	
	

	School Information
	
	
	
	
	
	
	
	
	

	Default Term Level
	
	
	
	
	
	
	
	
	

	Default Term When Between School Years
	
	
	
	
	
	
	
	
	

	Bell Schedule
	
	
	
	
	
	
	
	
	

	Calendar Setup
	
	
	
	
	
	
	
	
	

	Early Warning System
	
	
	
	
	
	
	
	
	

	Scheduling

	Scheduling Security
	
	
	
	
	
	
	
	
	

	Copy Master Schedule (Live Side)
	
	
	
	
	
	
	
	
	

	Periods
	
	
	
	
	
	
	
	
	

	Days
	
	
	
	
	
	
	
	
	

	Reset Class Counts
	
	
	
	
	
	
	
	
	

	Years and Terms

	Verify Start and End Dates
	
	
	
	
	
	
	
	
	

	Michigan TSDL Store Code
	
	
	
	
	
	
	
	
	

	Hide Schedules for Next School Year
	
	
	
	
	
	
	
	
	

	Attendance

	Attendance Codes
	
	
	
	
	
	
	
	
	

	Attendance Code Categories
	
	
	
	
	
	
	
	
	

	Full-Time Equivalencies
	
	
	
	
	
	
	
	
	

	Attendance Conversions
	
	
	
	
	
	
	
	
	

	Attendance Preferences
	
	
	
	
	
	
	
	
	



	Process
	School Buildings

	Grading

	GPA Calculations
	
	
	
	
	
	
	
	
	

	Final Grade Setups
	
	
	
	
	
	
	
	
	

	Current Grade Display
	
	
	
	
	
	
	
	
	

	GPA Student Screens
	
	
	
	
	
	
	
	
	

	Honor Roll
	
	
	
	
	
	
	
	
	

	Class Rank
	
	
	
	
	
	
	
	
	

	Student Information

	Full-Time Equivalency
	
	
	
	
	
	
	
	
	

	School Enrollments
	
	
	
	
	
	
	
	
	

	System Administration and Security

	Turn on AutoComm Processes
	
	
	
	
	
	
	
	
	

	Set Shorter Timeout for Admin Users
	
	
	
	
	
	
	
	
	

	Allow Users Back In & Sandbox Data
	
	
	
	
	
	
	
	
	

	PowerSchool Special Education - Email Leslie Budnick
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doingt)

[0 Allow Update of Enroll Status (Warning: Don't use this unless you know exactly what you are doing?)
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